Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically explained in this User's Guide, do not attempt to service this product yourself. Refer all servicing to qualified service personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Epson is a registered trademark and Exceed Your Vision, EasyMP, Easy Management, and Instant Off are trademarks of Seiko Epson Corporation.

PowerLite, PrivateLine, and Presenters Club are registered trademarks, SizeWise is a trademark, and Epson Connection, and Extra Care are service marks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

© 2006 by Epson America, Inc.
## Contents

Welcome .............................................................. 7  
Getting the Most from Your Projector ......................... 8  
Using Your Documentation ................................. 9  
  Getting More Information ............................... 9  
Registration and Warranty ...................................... 10  
Unpacking the Projector ........................................ 11  
  Additional Components ..................................... 11  
  Optional Accessories ...................................... 12  

1 Setting Up the Projector ........................................ 13  
Positioning the Projector ...................................... 14  
Connecting to Video Equipment ............................. 16  
  Connecting a Composite Video Source ................. 17  
  Connecting an S-Video Source ........................... 18  
  Connecting a Component Video Source .............. 19  
  Connecting an RGB Video Source ..................... 20  
Connecting to a Computer ..................................... 22  
  Connecting to the Computer Port ......................... 23  
Connecting an External Monitor ............................ 24  
Playing Sound Through the Projector ...................... 25  
  Connecting Audio Equipment to the Projector ....... 25  
  Connecting External Speakers ........................ 26
Welcome

The Epson® PowerLite® 6100i is a versatile projector designed to ensure that your presentations are easy and trouble-free, whether you use it in the classroom or conference room. When space is limited, you can project against a surface less than two and one-half feet away. The projector’s keystone correction function allows you to correct image distortion. In addition, the PowerLite 6100i offers outstanding image quality, with up to 3500 lumens of brightness, a resolution of 1024 × 768 pixels, and a 500:1 contrast ratio.

Your Epson PowerLite projector can be connected to two computer video sources at the same time, or four video sources. You can include an independent sound channel for each source.

Use the remote control to take charge of your presentation. Freeze the action, zoom in on part of the picture, or display a picture-in-picture video. You can also use the remote as a pointer, or to draw on the screen.

With the projector’s Easy Management™ system, you can use a Windows® PC to remotely monitor and control the projector.

To prevent unauthorized use of your PowerLite 6100i, you can assign a password, create a user logo which is displayed at startup to identify the projector, and disable the projector’s buttons through the Operation Lock feature. For more information about security features, see page 64.
**Getting the Most from Your Projector**

Depending on your presentation, you can take advantage of any or all of these options:

- **Connecting to a notebook or other computer**
  If you want to connect the projector to a notebook or desktop computer, see page 22. For additional presentation control, you can connect an external monitor to view the presentation on your computer simultaneously.

- **Connecting to video sources**
  You can connect a DVD player, VCR, HDTV, camcorder, laser disc player, digital camera, and other video sources to your projector. See page 16 for instructions.

- **Using the remote control**
  The remote control lets you switch from computer to video sources, zoom in on part of your image, freeze or mute the presentation, and adjust many other projector features. For details, see Chapter 3.

- **Including sound in your presentation**
  If your presentation includes sound, you can connect an optional audio cable to the projector to use the projector’s built-in speaker. See page 25.
Using Your Documentation

Your documentation includes a Quick Setup sheet, warranty brochures, and an Epson PrivateLine® Support card.

The Quick Setup sheet gives instructions for setting up and connecting your projector to a notebook computer.

This book contains all the information you need to set up and use your projector. Please follow these guidelines as you read through it:

- Warnings must be followed carefully to avoid bodily injury.
- Cautions must be observed to avoid damage to your equipment.
- Notes contain important information about your projector.
- Tips contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your projector? Here’s where you can look for help:

- presentersonline.com
  Includes a library of articles covering presentation tips, tricks, and technology. The site provides templates, clip art and sound clips, as well as Presenters Services to use on the road. Even more resources and services are available if you register to join the Presenters Club®—and it’s free.

- built-in help system
  Press the Help button on the remote control or projector to get quick solutions for common problems. See page 98 for details.

- support.epson.com
  Download FAQs (frequently asked questions) and e-mail your questions to Epson support.

If you still need help after checking this User’s Guide and the sources listed above, you can use the Epson PrivateLine Support service to get help fast. Call (800) 637-7661 and enter the PIN on your PrivateLine Support card. See page 109 for more information.
**Registration and Warranty**

Your projector comes with a basic carry-in warranty as well as an international warranty that let you project with confidence anywhere in the world. For details, see page 125 and the warranty brochure included with your projector.

In addition, for customers who register their projector, Epson offers free Extra CareSM Road Service. In the unlikely event of an equipment failure, you won’t have to wait for your unit to be repaired. Instead, Epson will ship you a replacement unit anywhere in the United States or Canada, usually via overnight delivery. See the Extra Care Road Service brochure for details.

To register, simply fill out the registration card that came with your projector and mail it to Epson. Or you can register online at:

http://www.epson.com/webreg

Registering also lets you receive special updates on new accessories, products, and service.
Unpacking the Projector

After unpacking the projector, make sure you have all the parts shown below:

- Projector
- Remote control and batteries
- Projector software CD-ROM
- Power cable
- VGA computer cable
- Cable cover

Save all packaging in case you need to ship the projector. Always use the original packaging (or the equivalent) when you need to send the projector to another location. If you are moving the projector by hand, use a carrying case (either an Epson case or something similar, such as a well-padded case). See page 12 for ordering information, and page 95 for transportation instructions.

Additional Components

Depending on how you plan to use the projector, you may need additional components:

- To receive an S-Video signal, you'll need an S-Video cable. One may be provided with your video equipment, or you can purchase one from Epson; see page 12.
- To receive a component video signal from a VCR or other video device, you'll need a component-to-VGA video cable. One may be provided with your video equipment, or you can purchase one from Epson; see page 12.
Optional Accessories

To enhance your use of the projector, Epson provides the following optional accessories:

<table>
<thead>
<tr>
<th>Product</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement lamp</td>
<td>V13H010L37</td>
</tr>
<tr>
<td>High efficient air filter (standard)</td>
<td>V13H134A11</td>
</tr>
<tr>
<td>Smoke filter</td>
<td>V13H134A12</td>
</tr>
<tr>
<td>Ceiling mount</td>
<td>ELPMBUNI</td>
</tr>
<tr>
<td>Suspension adapter</td>
<td>ELPMBAPL</td>
</tr>
<tr>
<td>False ceiling plate</td>
<td>ELPMBFCP</td>
</tr>
<tr>
<td>Adjustable ceiling channel</td>
<td>ELPMBACC</td>
</tr>
<tr>
<td>Security bracket/cabling</td>
<td>ELPMBSEC</td>
</tr>
<tr>
<td>Kensington® security lock</td>
<td>ELPSL01</td>
</tr>
<tr>
<td>Projection screens:</td>
<td></td>
</tr>
<tr>
<td>50-inch portable screen (4:3 aspect ratio)</td>
<td>ELPSC06</td>
</tr>
<tr>
<td>60-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC07</td>
</tr>
<tr>
<td>80-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC08</td>
</tr>
<tr>
<td>83.6-inch hanging pull-down screen (4:3 aspect ratio)</td>
<td>ELPSC09</td>
</tr>
<tr>
<td>S-Video cable</td>
<td>ELPSV01</td>
</tr>
<tr>
<td>Component video cable, 9.8 ft (for mini D-Sub 15-pin/RCA×3)</td>
<td>ELPKC19</td>
</tr>
<tr>
<td>Distribution amplifier</td>
<td>ELPDA01</td>
</tr>
<tr>
<td>ELPDC05 high resolution document imager</td>
<td>V12H162020</td>
</tr>
</tbody>
</table>

You can purchase these accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
1 Setting Up the Projector

This chapter gives you basic information on setting up the projector: where to position it and how to connect it to a video source (such as a VCR or DVD player) or to a notebook or desktop computer.

Follow the instructions in this chapter on:

■ Positioning the projector
■ Connecting to video equipment
■ Connecting to a computer
■ Connecting an external monitor
■ Playing sound through the projector
Positioning the Projector

If you’re setting up the projector yourself and it isn’t already installed in the classroom or conference room you’re using, you’ll probably want to place it on a table in front of the screen, as shown on page 15.

This lets you stand in the front of the room, face the audience, and remain close enough to the equipment to be able to control it. Try to leave as much space as possible between the projector and the screen to get a good-size image.

Use the figure below to help you determine placement. Image size increases with distance, but can vary depending on how you position the zoom ring and whether you’ve adjusted the image with other settings.

Also keep these considerations in mind:

■ Place the projector on a sturdy, level surface.

■ Make sure there is plenty of space for ventilation around and under the projector. Do not set the projector on top of loose papers that could block the vents under the projector.

■ Make sure the projector is within 10 feet of a grounded electrical outlet or extension cord.

---

**note**
You can mount the projector on the ceiling, or place it behind a translucent screen for rear projection. See page 111 for details.
Ideally, you should place the projector directly in front of the center of the screen, facing it toward the screen squarely. The lens should be at about the level of the bottom of the screen.

If you place the projector below screen level, you’ll have to tilt it up by extending its feet. This causes the image to become “keystone” shaped, but you can correct the distortion by pressing the $\Delta$ or $\nabla$ buttons on the projector. See page 36 for detailed information about correcting the image shape.

For instructions on installing the projector in a permanent location, such as a classroom or conference room, see page 111.
Connecting to Video Equipment

You can connect up to four video sources to the projector at the same time. Before starting, look at your video equipment to determine its available video-output connections:

- If your video player has a yellow RCA-style video output connector, see “Connecting a Composite Video Source” on page 17.
- If your video player has an S-Video connector, see “Connecting an S-Video Source” on page 18.
- If your video player has a component video port (three connectors labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a Component Video Source” on page 19.
- If your video player has an RGB video port (either a single connector for a VGA-style monitor cable, or three connectors labeled R/G/B), see “Connecting an RGB Video Source” on page 20.

After connecting the video cables, you may also want to connect an audio cable to play sound through the projector; see page 25.
Connecting a Composite Video Source

1. Locate an RCA-style composite video cable (one may be included with your video equipment).

2. Connect the cable to the yellow video output connector on your player and the yellow Video connector on the projector:

3. If you want to play sound through the projector, see page 25 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image.
Connecting an S-Video Source

1. Locate an S-Video cable (one is usually provided with your video equipment, or you can purchase one from Epson; see page 12).

2. Connect the cable between the S-Video connector on your player and the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 25 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image.
Connecting a Component Video Source

1. Locate a component-to-VGA video cable (you can purchase one from Epson; see page 12).

2. Connect the RCA end of the cable to your player and the VGA end to the Computer1 port on the projector.

3. If you want to play sound through the projector, see page 25 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 for instructions on turning on the projector and adjusting the image.

5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to Auto; see page 54.
Connecting an RGB Video Source

Follow these instructions to connect the projector to a video player that has an RGB video output port. Depending on the type of connector on your player, you'll need to use the appropriate cable:

- If your player has a VGA-style connector, see below.
- If your player has three connectors labeled R/G/B, see “Connecting Using a BNC-to-VGA Cable” on page 21.

Connecting Using a VGA-style Computer Cable

1. Locate the VGA computer cable provided with the projector.
2. Connect the cable between the video port on your player and the Computer1 port on the projector.
3. If you want to play sound through the projector, see page 25 for instructions on connecting an audio cable.
4. If you don’t need to make any other connections, see Chapter 2 for instructions on turning on the projector and adjusting the image.
5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to Auto; see page 54.
Connecting Using a BNC-to-VGA Cable

1. Locate a BNC-to-VGA video cable (one may be included with your video equipment).

2. Connect the BNC end of the cable to your player and the VGA end to the Computer1 port on the projector.

3. If you want to play sound through the projector, see page 25 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image.

5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to Auto; see page 54.
Connecting to a Computer

You can connect the PowerLite projector to any computer that has a standard video output (monitor) port, including desktop models, PC notebooks, Macintosh PowerBooks and iBooks, and hand-held devices. You can connect up to two computers at the same time to connect to the Computer port (standard VGA cable connection), see page 23.

After connecting to the computer, you may also want to:

- connect a monitor to the projector so you can view your presentation close-up as well as on-screen (not necessary if you’re using a notebook); see page 24
- connect an audio cable to play computer audio; see page 25
**Connecting to the Computer Port**

Follow these instructions:

1. Locate the VGA computer cable provided with the projector.
2. Connect one end to the projector’s **Computer** port, and the other end to your computer’s monitor port.
3. Optionally, you can connect an external monitor (see page 24), play sound through the projector (see page 25).
4. When you’ve finished making connections, see Chapter 2 for instructions on turning on the projector and adjusting the image.
5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to **Auto**; see page 54.

---

**caution**

Don’t try to force a connector to fit a port with a different shape or number of pins. You may damage the port or connector.
Connecting an External Monitor

If you want to monitor your presentation close-up (on a monitor placed beside the projector) as well as on the screen, you can connect an external monitor. You can use it to check on your presentation or switch between picture sources, even if you’ve pressed the A/V Mute button to turn off projection on the screen.

To attach an external monitor, connect it to the projector’s Monitor Out port, as shown:

Follow these guidelines to view images on the monitor:

- The monitor displays the image from the currently selected computer source.
- You can only view images on the monitor while the projector is powered on.
Playing Sound Through the Projector

You can play sound through the projector’s speaker system, or you can attach an external speaker system. (Attaching speakers to the projector instead of directly to the audio source lets you use the projector’s remote control to adjust the sound.)

Connecting Audio Equipment to the Projector

To play sound through the projector, follow these steps:

1. Obtain a commercially available stereo mini-jack or RCA-style audio cable. Which cable you use depends on how your equipment is connected:
   - If you have a computer connected to the Computer1, Computer2, or S-Video port, use a stereo mini-jack cable.
   - If you have video equipment connected to the Video port, use an RCA-style audio cable.
2. Connect the audio cable to the jack corresponding to the connected video source.
3. Connect the other end of the cable to the audio-output connector on your computer or video equipment.
Connecting External Speakers
To connect speakers to the projector, follow these steps:

1. Obtain the appropriate cable to connect your speakers.
   Depending on your stereo system, you may be able to use a commercially available audio cable with a stereo mini-jack connector on one end, and pin jacks on the other end. For some speaker systems, you may have to purchase a special cable or use an adapter to connect to your speakers.

2. Connect the stereo mini-jack end of the audio cable to the Audio Out port on the projector.

3. Connect the other end(s) of the cable to your speaker system. You may need to use an adapter to make the connection.

The projector’s internal speaker system is disabled while sound is output to the external speakers.
2

Projecting

Once you’ve set up the projector, you’re ready to turn it on, adjust the image, and give your presentation.

Although you can operate the projector without it, the remote control lets you use additional features. See Chapter 3 for instructions on using the remote.

Follow the guidelines in this chapter for:

■ Turning the projector on and selecting the image source
■ Troubleshooting display problems
■ Adjusting the image
■ Adjusting the volume
■ Shutting down the projector
**Turning On Your Equipment**

Make sure your projector and other equipment are set up as described in Chapter 1. Then follow the instructions below to start the projector and display an image.

If you turn on any connected computer or video equipment before starting the projector, this lets the projector automatically detect and display the image source. If you turn on the projector first, or have multiple pieces of connected equipment, you may have to select the image source manually (see page 30).

**Turning On the Projector**

Follow these steps to turn on the projector:

1. Plug one end of the power cable into the projector, and the other end into a grounded electrical outlet.

2. Wait until the Power light stops flashing and turns orange.

*note*

To shut down the projector, see page 39. Shutting down the projector correctly prevents premature lamp failure and possible damage from overheating.
3. Press the orange Power button on top of the projector—or press the Power button on the remote control.

(If this is your first time using the remote control, make sure the batteries are installed; see page 43.)

The Power light flashes green as the projector warms up, and an image begins to appear. When the Power light stops flashing and remains green (in about 20 seconds) the projector is ready for use.

4. If you’ve connected a Windows-based computer to the projector, you may see a New Hardware Wizard saying your computer has found a plug-and-play monitor; if so, click Cancel.

---

**note**

If the Direct Power On feature has been enabled, you don’t need to press the Power button to turn the projector on. Just plug the projector into an electrical outlet. When the Power light stops flashing and stays on, the projector is ready to use.

---

**warning**

Never look into the lens when the lamp is on. This can damage your eyes, and is especially dangerous for children.
Selecting the Image Source

Selecting the image source lets you switch between images input from different pieces of equipment connected to the projector (such as a computer or DVD player).

If you don’t see the image you want, select it using the Source Search button on the projector or the Source buttons on the remote control.

The Source buttons work as follows:

- Use the Source Search button to switch between equipment connected to the Computer1, Computer2, Video, and S-Video ports.

- The remote control has four Source buttons. Use them to switch between equipment connected to the port identified on each button.

Note that the Computer1 and Computer2 ports can be set up to use different input signals (for example, Analog RGB or RGB Video)—so if you have equipment connected to one of these ports, it’s important to make sure the correct signal is selected to match the equipment you’re using. You can change the input signal settings using the projector’s menu system; see page 54.
What To Do If You See a Blank Screen

If you see a blank screen or a blue screen with the No Signal message, try the following:

■ Make sure the cables are connected correctly, as described in Chapter 1.

■ Make sure the Power light is green and not flashing and the lens cap is off.

■ If you’ve connected more than one computer and/or video source, you may need to press the Source Search button on the projector’s control panel or one of the Source buttons on remote control to select the correct source. (Allow a few seconds for the projector to sync up after pressing the button.)

■ If you’re using a PC notebook, press the function key on your keyboard that lets you display on an external monitor. It may be labelled CRT/LCD or have an icon such as . You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.

The Projector and Notebook Don’t Display the Same Image

If you’re projecting from a notebook, and you can’t see your image on the screen and on your computer at the same time, follow these guidelines.

If you’re using a PC notebook:

■ On most systems, there’s a function key that lets you toggle between the LCD screen and the projector, or display on both at the same time. It may be labelled CRT/LCD or with an icon such as . You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.

■ If the function key doesn’t permit you to display simultaneously on both screens, you should check your monitor settings to make sure both the LCD screen and the external monitor port are enabled.
From the Control Panel, open the Display utility. In the Display Properties dialog box, click the Settings tab, then click Advanced. The method for adjusting the settings varies by brand; you may need to click a Monitor tab, then make sure the external Monitor port is set as your primary display and/or enabled. See your computer’s documentation or online help for details.

If you’re using Macintosh OS X:
You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple menu, select System Preferences, then select Displays.
2. Make sure the VGA Display dialog box is selected.
3. Click the Arrange tab.
4. Make sure the Mirror Displays checkbox is selected.
**If you’re using OS 8.6 to OS 9.x:**

You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple menu, select **Control Panels**, then click **Monitors** or **Monitors and Sound**.
2. Click the **Arrange** icon.

![Arrange icon](image)

3. Drag one monitor icon on top of the other.

If the Arrange option isn’t available, you may need to select one of the Simulscan resolution settings:

1. Click the **Monitor** icon.

![Monitor icon](image)

2. Select a **Simulscan** resolution as shown. (Allow a few seconds for the projector to sync up after making the selection.)
Adjusting the Image

Once you see your image, you need to make certain adjustments:

■ To focus or zoom your image, see below.

■ If the image is too high or too low, you can reposition it. See page 35.

■ If the image isn’t square, see page 36.

■ If a computer image displays incorrectly, see page 38.

If you need to fine-tune the image and/or sound, see Chapter 4.

Focusing and Zooming Your Image

Open the lens access door, then do the following:

■ Use the Focus ring on the projector to sharpen the image.

■ Use the Zoom ring on the projector to reduce or enlarge the image. Move the tab toward the W to increase the size, and toward the T to decrease it.

If the image still isn’t large enough, you may need to move the projector farther away from the screen. You can also use the E-Zoom buttons on the remote control to zoom in on a portion of the image. See page 45 for instructions.
**Adjusting the Height of Your Image**

If the image is too low on the screen, you can use the front adjustable feet to raise it.

1. Lift the front of the projector and turn the front feet to adjust the position of the projected image.

2. If necessary, you can fine-tune the height by turning the projector’s front feet without lifting the front of the projector.

Raising the projector causes the image to distort or “keystone,” but you can correct the shape as described in the next section.


**Adjusting the Image Shape**

In most cases, you can maintain a square or rectangular image by placing the projector directly in front of the center of the screen with the base of the lens level with the bottom of the screen.

If the projector is slightly tilted (within a range of 30° up or down), you can use the **Keystone** keys on the projector’s control panel or the projector’s Keystone menu (see “Using Keystone Correction” on page 37) to correct vertical keystone distortion.

If your image is shaped like , or , you’ve placed the projector off to one side of the screen at an angle. Place it directly in front of the center of the screen, facing the screen squarely.
Using Keystone Correction

To adjust your image when it is wider on one side, do the following:

- Press the \( \swarrow \) or \( \searrow \) buttons on the projector until you are satisfied with the shape of the image.

- Or press the Menu button on the remote control, select the Settings menu, and press Enter. From the Settings menu, select Keystone and press Enter. Use the pointer button on the remote control to adjust the keystone setting as needed.

**note**
The image will be slightly shorter after adjusting.
Correcting Computer Images

If you’re connected to a computer and the image doesn’t look right, press the Auto button on the remote control (or the Auto/Enter button on the projector’s control panel). This automatically resets the projector’s tracking, sync, resolution, and position settings.

If vertical stripes appear in the projected image and the Auto button doesn’t correct the problem, adjust the projector’s Tracking setting. See page 106 for instructions.

If the image appears fuzzy or flickers and the Auto button doesn’t correct the problem, adjust the projector’s Sync setting. See page 106 for instructions.

Adjusting the Volume

You can use the buttons on the remote control or projector to increase or decrease the volume for the projector’s built-in speaker or external speakers connected to the projector. Press the button to increase the volume, or the button to decrease it.

Note
You must be projecting an image for this button to have any effect. The Auto button works only with computer images.

Make sure Auto Setup is turned on to adjust the source automatically; see page 55.

Note
You can also adjust the volume using the projector’s menu system. See page 57.
Shutting Down the Projector

When you’ve finished using the projector, follow the recommended procedure to shut it down. This extends the life of the lamp and protects the projector from possible overheating.

1. Turn off and disconnect any equipment plugged into the projector.

2. To turn off the projector, press the Power button twice.

3. When the Power light is steady orange, you can unplug the projector.

With Epson’s exclusive Instant Off™ technology, there’s no cool-down period, so you can pack and go immediately after turning off the projector.

---

**note**

When the projector has not received any input signals for 30 minutes, it automatically turns off the projector lamp and enters “sleep mode.” This conserves electricity, cools the projector, and extends the life of the lamp. If you want to start projecting again, press the Power button. If you are done using the projector, unplug the power cord. To turn off sleep mode, see page 59.

Turn off this product when not in use to prolong the life of the projector.

---

**caution**

To avoid damaging the projector or lamp, never unplug the power cord when the Power light is green or flashing orange.
Using the Remote Control

The remote control lets you access your projector’s features from anywhere in the room—up to 33 feet away. For example, you can turn the projector on and off, preview and switch between picture sources, turn off picture and sound, freeze the presentation, zoom in on a portion of your image, and access the menu system. (The projector menus let you adjust many projector settings; see Chapter 4).

This chapter covers:

■ Using the remote control
■ Controlling the picture and sound
■ Highlighting your presentation
Using the Remote Control

Before using the remote, make sure batteries are installed as described on page 43. Then, refer to the tips below:

- Point the remote control either at the front or back of the projector, or at the screen.
- Stand within about 30 feet of the projector.
- Avoid using the remote under bright fluorescent lamps or in direct sunlight, or the projector may not respond properly.

Using the Navigation Buttons

The remote control has various buttons that let you navigate the projector’s help and menu systems; they also let you use the drawing tools to highlight your presentation.

For details on using the buttons to control specific features, see the following sections:

- to navigate the projector’s menu system, see page 50
- to use the projector’s help system, see page 98
- to highlight your presentation, see page 46
Replacing the Batteries

The remote control uses two AAA alkaline batteries. Follow these steps when you need to replace them:

1. Press in the tab to remove the battery cover.

2. Remove the old batteries, then insert the new ones as shown.

3. Replace the battery cover. (It should click into place.)

caution
When replacing batteries, take the following precautions:

- Replace the batteries as soon as they run out. If the batteries leak, wipe away battery fluid with a soft cloth. If fluid gets on your hands, wash immediately.
- Do not expose batteries to heat or flame.
- Dispose of used batteries according to local regulations.
- Remove the batteries if you won’t be using the projector for a long period of time.
Controlling the Picture and Sound

You can use the remote control to select your picture sources, temporarily turn off the picture and sound, freeze the action, zoom in on the picture, and adjust the volume.

Switching Between Picture Sources

If your projector is connected to more than one computer and/or video source, you can switch between the different sources:

- On the projector’s control panel, there is a Source Search button. Press the button to switch between equipment connected to the Computer1, Computer2, Video, and S-Video ports.
- On the remote control, there are four Source buttons. Use them to switch between equipment connected to the port identified on each button.

After you select a source, the screen goes dark for a moment before the image appears.

Turning Off the Picture and Sound

You can use the A/V Mute button on the remote control to turn off the image and sound and darken your screen. (If you’ve connected an external monitor to the projector, it will continue displaying.) This feature is useful if you want to temporarily redirect your audience’s attention without the distraction of a bright screen.

- To turn off the picture, press the A/V Mute button. The screen goes dark.
- To turn the image back on, press the button again.

You can also have an image, such as a company logo, display on the screen whenever you press the A/V Mute button (see page 58).
Stopping Action

You can use the remote control to stop the action in your video or computer image.

■ Press the Freeze button to stop the action and keep the current image on the screen. The sound continues.
■ Press the Freeze button again to restart it.

Zooming Your Image

You can zoom in on a portion of the image using the E-Zoom buttons on the remote control.

1. Press the E-Zoom $\Theta$ button on the remote control.
   You see a cross-hair indicating the center of the zoom-in area.
2. Use the $\odot$ pointer button to position the cross-hair.
3. Continue pressing the E-Zoom $\Theta$ button to enlarge the selected area up to 4×.
4. While the image is enlarged, you can:
   ■ Use the $\odot$ pointer button to pan about.
   ■ Press the E-Zoom $\Theta$ button to zoom out.
5. When done, press the ESC button to return to the original size.

Note

This function pauses the image, but not the sound. Also, because the source continues to transmit signals, you won’t resume the action from the point you paused it.
**Highlighting Your Presentation**

You can display a pointer to call out something on the screen or emphasize particular points. There are three pointer shapes you can choose from.

**Using the Pointer Tool**

1. To activate the pointer tool, press the **Pointer** button on the remote control. A pointer appears on the screen.

2. Use the pointer button on the remote control to position the pointer on the screen.

3. When done using the pointer, press the **Esc** button on the remote control.

   ![Pointer Image]

   If you prefer to use a different pointer, see page 47 for instructions on changing the pointer shape.
Changing the Pointer Shape

Follow the steps below to change the pointer shape.

1. Press the Menu button on the remote control, highlight the Settings menu, and press Enter.

   You see this screen:

   ![Screen Shot]

2. Highlight Pointer Shape and press Enter.

3. Select the pointer you would like to use, then press Enter to select it.

4. When you have finished selecting a pointer shape, press the Menu button to exit the menu system.
Configuring the Projector

You can use the projector’s on-screen menus to adjust the image, sound, and other features. This chapter covers the following information:

- Using the menu system
- Adjusting color and clarity
- Adjusting the input signal
- Customizing projector features
- Selecting projector setup options
- Selecting network settings
- Viewing lamp usage and other information
- Using the projector’s security features
Using the Menu System

You can use the remote control (or the projector’s control panel) to access the menus and change settings. Follow these steps:

1. To display the menu screen, press the Menu button.

   You see a menu screen similar to the one shown below (the settings may differ from those shown here, depending on the selected input source):

   The menus are listed on the left, and the options available for the highlighted menu are shown on the right.

2. Use the pointer button on the remote control (or the arrow buttons on the projector) to scroll through the menu list. When you’ve highlighted the desired menu, press the Enter button to select it.

3. Once you’ve selected the menu, use the pointer button to scroll through the list of options. (Some of the options may be grayed out or unavailable, depending on the selected source.)
4. After highlighting the option you want to adjust, use the pointer button to change the setting. In some cases, you may have to press the Enter button to see a sub-screen for changing the setting.

- Press the left or right side of the pointer button to adjust a slider bar.
- To select from two or more settings, use the pointer button to highlight the desired setting, then press Enter.

5. After changing the settings, press the Esc button to save your changes and return to the previous menu (or press it repeatedly to exit the menu system).

You can also press the Menu button to exit.

**Restoring the Default Settings**

You can use the menu system’s Reset options to restore the factory-default settings for:

- all the settings listed in a specific menu

- all the settings in all menus

To restore the settings in a specific menu, enter the menu whose settings you want to change, select Reset, and confirm as needed. (The example below shows how to reset the Image menu.)

To restore all the projector settings to their factory-default values, select the Reset menu, then select Reset All.

---

**note**

Reset All does not reset the Computer Inputs, User’s Logo, Language, Screen ID, Network, or Lamp settings. To reset the Computer Inputs, use the Reset option on the signal menu. To reset the User’s logo and Language settings, use the Reset option on the Extended menu.
Adjusting Colors and Clarity

The Image menu lets you make adjustments to the colors of the projected image and fine-tune brightness, contrast, and sharpness. The options available depend on which image source is selected.

1. Press the Menu button on the remote control, then Press the Enter button to select the Image menu.

You see the Image menu screen. (The actual settings may vary, depending on the selected input source. The Image menu below is for a component video, composite video, or S-Video source.)

2. Use the  pointer button to highlight menu items, then press the Enter button to select from any of the following options:

- **Color Mode**
  Corrects the vividness of image color. You can select from the following six settings:

  - **Photo**: For displaying still photos in vivid color and high contrast in a bright room.
  - **Sports**: For watching TV in a bright room.
  - **Presentation**: For presentations in a bright room.
  - **Theatre**: For optimizing movie images with natural color in a dark room.
  - **Game**: For playing video games in a bright room.
  - **sRGB**: For projecting standard sRGB computer displays.
  - **Blackboard**: Fixed color mode for projecting against a green blackboard.
■ Brightness
Lightens or darkens the overall image.

■ Contrast
Adjusts the difference between light and dark areas.

■ Color Saturation
Adjusts the depth or intensity of the image colors.

■ Tint
Adjusts the tint of the image (not available for RGB video images).

■ Sharpness
Adjusts the sharpness of the image.

■ Color Adjustment
Adjusts the temperature and intensity of red, green, and blue.

3. When the image is set correctly, press Esc or Menu. Your settings are automatically saved.

**note**
The Brightness setting changes the opacity of the projector’s LCD panels. You can also adjust the brightness of the lamp itself. Select Brightness Control in the Settings menu, then choose High or Low (the default setting is High). Selecting the low brightness setting extends the life of the lamp (see page 116).
Configuring the Projector

Adjusting the Input Signal

1. Press the Menu button on the remote control, highlight Signal, then press the Enter button to select the Signal menu.

You see one of the following screens:

- **Computer (analog RGB) and RGB video**

- **Component video**

- **Composite video and S-Video**
2. Use the \(\bigcirc\) pointer button to highlight menu items, then press the \textbf{Enter} button to select from any of the following options:

- **Auto Setup** (computer images)
  Leave this setting \textbf{On} to automatically optimize the computer image when you switch to a computer source. Turn it \textbf{Off} if you want to save adjustments you have made to the video settings below.

- **Tracking** (computer images)
  Removes unwanted vertical lines from a computer image by matching the projector’s internal clock to various computer signals. See page 106 for more information about adjusting the tracking setting.

- **Sync.** (computer images)
  Corrects fuzziness or screen flicker by synchronizing the projector with the tracking signal sent from the computer. See page 106 for more information about adjusting the sync. setting.

- **Position**
  Use the \(\bigcirc\) pointer button to move the image on the screen left, right, up, or down.

- **Computer1 Input**
  Selects the signal from equipment connected to the \textbf{Computer1} port. If your image colors look wrong, try changing this setting from \textbf{Auto} to \textbf{RGB} for computer or RGB video sources, or to \textbf{Component Video} for component video sources.

- **Computer2 Input**
  Selects the signal from equipment connected to the \textbf{Computer2} port. If your image colors look wrong, try changing this setting from \textbf{Auto} to \textbf{RGB} for computer or RGB video sources, or to \textbf{Component Video} for component video sources.

- **Video Signal** (composite and S-Video)
  Leave this setting at \textbf{Auto} unless you are using a 60-Hz PAL system (select \textbf{PAL60}).
■ **Resize (video)**
Sets the image’s aspect ratio (ratio of width to height) to 4:3 for letterbox video content and to 16:9 for widescreen video content.

3. When you’re finished, press **Esc** or **Menu**.

---

**Customizing Projector Features**

The Settings menu lets you customize the way you use the projector, from adjusting lamp brightness and speaker volume to changing the shape of the pointer.

1. Press the **Menu** button on the remote control, highlight **Settings**, then press the **Enter** button to select the Settings menu.

2. Use the pointer button to highlight menu items, then press the **Enter** button to select from any of the following options:

   - **Keystone**
   Adjusts a distorted image from a trapezoid shape to rectangular when the projector is tilted up or down.

   - **Operation Lock**
   In **Full Lock** mode, disables all of the projector’s buttons, including the **Power** button. In **Partial Lock** mode, disables all of the projector’s buttons except the **Power** button. Changes to this setting take effect after you restart the projector. (After you turn off the projector, wait for the **Power** light to turn solid orange before turning it on again.)

   **note**
   To cancel the Operation Lock function from the projector, press the **Enter** button for about seven seconds.
■ **Pointer Shape**
  Lets you select from three different pointer shapes. The Password Protect function must be cancelled first. See page 69.

■ **Brightness Control**
  Allows you to select Low lamp brightness when the projection is too bright for the room. The Low setting also reduces electricity consumption and fan noise. Select High to project at the maximum brightness. (Also check the Brightness setting in the Image menu; see page 53.)

■ **Volume**
  Adjusts the volume for the projector’s speaker.

■ **RCA Audio Input**
  Lets you change the L-Audio-R audio port as the input for the Video port or S-Video port. Select Video to use the RCA port for the Video port. Select S-Video to use the RCA port for the S-Video port.

■ **Remote Receiver**
  Select Off to disable the remote control receivers on the projector to prevent interference from fluorescent lighting or other sources. Or enable specific receivers using the following settings: Front/Rear, Front, or Rear.

■ **Test Pattern**
  Allows you to adjust the projector without a video source. While the test pattern is displayed, you can make Zoom, Focus, and Keystone adjustments.

3. When you’re finished, press Esc or Menu.
Selecting Projector Setup Options

Use the Extended menu to customize the way you set up the projector. You can configure the projector for rear and/or ceiling projection, change the language for the menus and messages, set the screen background color, capture and store a custom image or logo for the startup screen, and set up the projector for network use.

1. Press the Menu button on the remote control, highlight Settings, then press the Enter button to select the Settings menu.

2. Use the pointer button to highlight menu items, then press the Enter button to select from any of the following options:

- **Display**
  - **Message**: Lets you turn screen messages On and Off.
  - **Display Background**: Sets the screen background to Black, Blue, or Logo when the projector isn’t receiving a video signal.
  - **Startup Screen**: Enables or disables display of the startup screen when the projector is turned on.
  - **A/V Mute**: Sets the screen background to Black, Blue, or Logo when the A/V Mute button is pressed.
  - **Closed Caption**: Lets you select from the following closed caption settings: Off, CC1, CC2, CC3, CC4, TEXT1, TEXT2, TEXT3, or TEXT4.

---

**note**
The Startup Screen option cannot be turned off if the User’s Logo Protect feature has been turned on. See page 69.
■ User’s Logo
Turn this setting On to display the image or logo you have captured whenever the projector is turned on. See page page 65 for more information.

■ Projection
Front: Projector is in front of the screen.
Front/Ceiling: Projector is in front of the screen, mounted upside-down from the ceiling.
Rear: Projector is behind the screen.
Rear/Ceiling: Projector is behind the screen, mounted upside-down from the ceiling.

■ Operation
Direct Power On: When this feature is enabled, projection starts as soon as you plug in the power cord. You don’t have to press the Power button.

Sleep Mode: When this feature is enabled, the projector’s lamp automatically turns off when the projector has not received any input signals for more than 30 minutes. This conserves electricity, cools the projector, and extends the life of the lamp. To resume projecting, press the Power button.

High Altitude Mode: Turn this setting On when using the projector above an altitude of 4,921 feet.

■ Standby Mode
Select Network On to use the network monitoring and control functions while the projector is in standby mode.

■ Air Filter Setting
Alarm Timer: Lets you turn the air filter replacement notification on or off. If you are using the smoke air filter, make sure this setting is turned On.

Timer: Lets you change the amount of time the projector waits before displaying the air filter replacement notification.

**note**
When Direct Power On is enabled, press the Power button to turn the projector off, wait until the Power light remains solid orange, then unplug the projector.
■ Multi-screen

**Screen ID:** Lets you set individual IDs for multiple projectors when performing Image Correction adjustments. This allows you to use one remote control for all of the projectors. To select a projector, press and hold the **Num** button on the remote control while pressing the number button that corresponds to the projector’s Screen ID.

**Image Correction**

**Adjustment Level:** Select each Adjustment Level (1 to 5) one at a time and adjust the Brightness Correct and Color Correct settings until the projected images match on all of the projectors.

**Brightness Correct:** Lets you adjust the difference in brightness for each projector.

**Color Correct:** Lets you adjust the difference in color for each projector.

■ Language

Lets you select the language to be used for the projector menus.

3. When you’re finished, press **Esc** or **Menu**.
Selecting Network Settings

Use the Network menu to configure the projector’s network settings and set it up for network use.

1. Press the Menu button on the remote control, highlight Network, then press the Enter button to select the Settings menu.

2. Use the joystick button to highlight menu items, then press the Enter button to select from any of the following options:

- **Wired LAN**
  - DHCP: Lets you turn DHCP On or Off.
  - IP Address: Lets you assign an IP address to the projector.
  - Subnet Mask: Lets you assign a subnet mask to the projector.
  - Gateway Address: Lets you assign a gateway address to the projector.
  - MAC Address: Lets you view the projector’s MAC address.

- **PJLink Password**
  Lets you assign a password to be used when accessing the projector with PJLink software.

- **Web Control Password**
  Lets you assign a password to be used when accessing the projector using Web Control.
■ **SNMP**

**Trap IP Address 1**: Lets you register an SNMP trap notification destination.

**Trap IP Address 2**: Lets you register a second SNMP trap notification destination to be used if the projector cannot access the IP address registered in Trap IP Address 1.

**Community Name**: Lets you assign a community name for SNMP. You can register up to eight numbers and letters.

■ **Mail**

**Mail Notification**: Turn this setting on to have the projector send you an e-mail when it detects a problem.

**SMTP Server**: Lets you define your SMTP server address information to the projector.

**Port Number**: Lets you define your SMTP server’s port number to the projector.

**Address 1 Setting**: Lets you register an e-mail address where you can be notified when the projector detects a problem.

**Address 2 Setting**: Lets you register a second notification e-mail address.

**Address 3 Setting**: Lets you register a third notification e-mail address.

■ **Projector Name**

Lets you assign a unique name to the projector to identify it on the network.

3. When you are finished, press the Esc or Menu button.
Viewing Lamp Usage and Other Information

Use the Info menu to view information about the display settings of your computer and video devices and the number of hours the lamp and filter have been used.

1. Press the Menu button on the remote control, highlight Info, then press the Enter button to select the Settings menu.

You see one of the following menus:

- **Lamp Hours**
  Displays the number of hours the lamp has been used. The life span of the lamp ranges from about 2500 hours in High brightness mode to about 3000 in Low brightness mode. If the number shown is close to 2500 or the information is displayed in red, make sure you have a spare lamp handy.

**note**
The lamp usage timer doesn’t register until you’ve used the lamp for at least 10 hours.

Configuring the Projector 63
### Configuring the Projector

- **Air Filter**
  Displays type of air filter and the number of hours it has been used.

- **Source**
  Displays the input source currently being used.

- **Input Signal** (computer, RGB video, and component video)
  Displays the input signal currently being used.

- **Resolution** (computer, RGB video, and component video)
  Displays the input resolution currently being used.

- **Refresh Rate** (computer, RGB video, and component video)
  Displays the refresh rate.

- **Sync Info** (computer, RGB video, and component video)
  Displays information that may be needed by a service technician.

- **Video Signal** (composite and S-Video)
  Displays the video signal format currently being used.

---

#### Using the Projector’s Security Features

To prevent unauthorized use of the projector, you can do the following:

- Create an identifying user logo that is displayed at startup and/or when the A/V Mute button is pressed

- Assign a password that’s required to be entered every time the projector is turned on; this can be disabled for a set period of time if you want to loan the projector to someone

- Disable the projector’s buttons; this is useful, for example, if you’re projecting in a classroom and you want to ensure that no one touches the projector’s buttons while you’re using the remote control

---

**note**
The air filter usage timer doesn’t register until you’ve used the filter for at least 10 hours.
If you assign the projector a password, a screen appears requesting the password whenever the projector is turned on. If you enter the password incorrectly three times in succession, the projector’s operation is locked and you’ll need to disconnect the power cord, then reconnect it to redisplay the password screen. If an incorrect password is entered 30 times in a row, the projector is locked and you’ll need to contact Epson to unlock it. See “Where To Get Help” on page 109.

If someone else will be using the projector for awhile but you want to make sure the person returns it by a certain time, you can temporarily disable the password for a set period of time. When that time has elapsed, the password is reactivated and must be entered before the projector can be used.

When you enable the Operation Lock feature, all of the projector’s buttons are disabled except the Power button.

Creating Your Own Screen Logo

You can transfer any image on your computer to the projector, and then use it as the startup screen and/or the screen that is displayed when you press the A/V Mute button. The image can be a company logo, slogan, photograph, or any other image you want to use. The projector considers this image the User’s Logo.

If you create a user’s logo for the projector, you can lock the logo on so it is displayed as the startup screen and/or A/V Mute screen. Unauthorized users cannot turn it off or change it. This feature is intended to discourage theft and provides a way to identify the projector should it be stolen.

Follow the steps below to capture the image and transfer it to the projector:

1. Display the image you want to use on the projector. You can use an image from either a computer or video source, such as a VCR.
2. Press the Menu button on the remote control, highlight Extended, then press the Enter button.

*note*

If you should happen to enable the password before you set one and you see the prompt to enter the password, enter the default password **0000** to proceed.
3. Use the \( \odot \) pointer button to highlight User’s Logo, then press the Enter button.

4. When you see the message **Choose this image as the User’s Logo?**, select Yes and press Enter. A selection box displays over the image.

5. Use the \( \odot \) pointer button on the remote control to select the area of the image you want to use. Once you have selected the area, press Enter.

6. When you see the message **Select this image?**, choose Yes and press Enter.

   If you want to change the area selected, select No, press Enter and repeat steps 4 through 6.

---

**note**

If the User’s Logo Protect function is enabled, you see a message that the logo cannot be recorded. You’ll need to disable the User’s Logo Protect function before you can create or change the User’s Logo. See page 69.
7. When you see this screen, select a zoom rate (display size), and press Enter.

8. When you see the message *Save this image as the User’s Logo?*, select *Yes* and press Enter. Saving the logo takes a few moments. Do not use the projector or other sources (computer, video, etc.) while the logo is being saved.

9. When you see the message *Completed*, press Esc.

**Displaying Your Screen Logo**

Follow the steps below to display your logo when there is no signal, when the projector is turned on, and when the A/V Mute button is pressed:

1. Press the *Menu* button on the remote control, select the *Display* menu, and press Enter.

2. To display your logo when the projector is not receiving a video signal, select *Display Background* and press Enter.

3. Select *Logo* and press Enter.

4. Press the *Esc* button on the remote control to return to the Display menu.

5. To display your logo when the projector is turned on, select *Startup Screen* and press Enter.

6. Select *On*, then press the Enter button.

7. Press the *Esc* button on the remote control to return to the Display menu.

**note**

*Once you’ve saved a User’s Logo, you cannot reset the logo setting to its factory defaults (no logo).*

**note**

*If the User’s Logo Protect feature has been enabled, the Display Background setting cannot be changed. You will need to turn the protect function off first. See page 69 for details.*
8. To display your screen logo when the A/V Mute button is pressed, select A/V Mute and press Enter.


10. When you’re finished, press the Menu button on the remote control to exit the menu system.

### Setting a Password

Follow the steps below to set a password for the projector.

1. Press and hold down the Freeze button on the remote control until you see the Password Protect menu:

2. Select Password and press Enter.

3. When you see the Change the password? message, select Yes and press Enter.

4. Press and hold down the Num key on the remote control while you use the numeric keypad to enter a 4-digit password.

   The password will be displayed as ****. After you enter the last digit, a confirmation screen appears. Enter the password again.

5. After you are finished setting the password, press the Menu button to exit to the Password Protect menu.

Make a note of the password and keep it in a safe place in case you forget it.
Protecting your Screen Logo

When the User Logo Protect setting is set to On, none of the User’s Logo features can be changed. Make sure you’ve set a password for the projector as described on page 68. Then follow the steps below to enable the User Logo Protection setting:

1. Press and hold down the **Freeze** button until you see the Password Protect menu.

2. To protect your logo from being changed or disabled, select **User’s Logo Protect** and press **Enter**.

3. Select **On** and press **Enter**.

4. Press **Menu** to exit the Password Protect menu.

If you lose the remote control, you will not be able to enter the password, so keep the remote control in a safe place at all times.

---

**note**

If you are prompted for a password, press and hold down the **Num** key on the remote control while you use the numeric keypad to enter the password.

If you enter the password incorrectly three times in succession, the projector’s operation is locked and you’ll need to turn it off and disconnect the power cord, then reconnect it. If an incorrect password is entered 30 times in succession, the projector is locked and you’ll need to contact Epson to unlock it. See "Where To Get Help" on page 109.
Turning on Password Protection

If you enable the Power On Protect setting, a screen appears requesting the password whenever the projector is turned on. If you loan the projector to someone, but you want to make sure that they return it by a certain time, you can disable the password for a set period of time. When that time has elapsed, the password is reactivated and must be entered before the projector can be used.

Make sure that you’ve set a password for the projector as described on page 68. Then follow the steps below:

1. Press and hold down the Freeze button until you see the Password Protect menu:


3. Press Esc to return to the Password Protect menu.

4. If you want to disable the password temporarily, select Password Timer and press Enter. Then select On and Press Enter.

5. Press Esc to return to the Password Protect menu.

6. Select Timer and press Enter. Hold down the Num button on the remote control while you use the numeric keypad to enter the number of hours to disable the password for, then press Enter.

When the period defined in the Timer setting has passed, and the password is entered correctly, the elapsed time will be reset to 0 and the countdown will start again. Remember to disable or change this setting when you need to.

If you lose the remote control, you will not be able to enter the password, so keep the remote control in a safe place at all times.
**Starting the Projector with a Password**

When the password function is enabled, you see a password entry screen when you turn on the projector.

Press down the Num button on the remote control as you use the numeric keypad buttons to enter the password. Once you have entered the password correctly, the password screen closes, and projection begins.

If the password is not correct, you see the message **Wrong password. Please try again.** If you enter an incorrect password three times in succession, you see the message **The projector’s operation will be locked. Request code xxxxx** and the projector switches to standby mode for approximately 5 minutes. Write down the request code. Then disconnect the projector’s power cord from the electrical outlet, reconnect it, and turn the projector back on.

When you see the password prompt again, you can try to re-enter the correct password.

If you have forgotten the password, contact Epson with the request code number that appears in the Password Protect Release screen for assistance. See “Where To Get Help” on page 109.

If you enter an incorrect password 30 times in succession, the projector remains locked and you must contact Epson to unlock it.

**Disabling the Projector’s Buttons**

When you enable the Operation Lock function, all of the projector’s buttons are disabled except for the Power button.

1. Press the Menu button on the remote control, highlight Settings, then press the Enter button.
2. Select Operation Lock and press Enter.
3. Select Full Lock to lock all of the buttons on the control panel or Partial Lock to lock all of the buttons on the control panel except for the Power button, then press Enter.
4. Select Yes and press Enter to confirm the setting.
5. Press the Menu button to exit the menu system.

---

**note**

To cancel the Operation Lock, press the projector’s **Enter** button on the projector for seven seconds.
Managing the Projector from a Remote Computer

Your projector’s Easy Management software lets you monitor and control your projector(s) from a remote computer in several ways:

- Use EMP Monitor to see your projectors’ status, switch image sources, and control basic settings.
- Use the e-mail notification function to receive alerts about possible problems.
- Use a network management utility running SNMP, such as HP OpenView™, to manage your facility’s equipment from a pre-existing system.

To use the Easy Management software to manage your projector(s), first install it as described on page 74. Then connect and configure each projector you want to monitor, so it can be recognized on your network (see page 75).

This chapter covers the following information:

- Installing the Easy Management software
- Connecting the projector to the network and configuring it
- Using EMP Monitor
- Using e-mail alerts
- Understanding the notifications messages
- Using a browser to monitor the projector

*note*  
A plug-in will be available to allow you to manage your projectors in HP OpenView. Check with your dealer or Epson for availability (see page 109).

If you’re using a network management utility running SNMP, you can configure your network to send trap alerts even without a plug-in (see page 75). This feature is intended for use by network administrators only.
Installing the Easy Management Software

The projector software CD-ROM includes the software you need to use EMP Monitor.

System Requirements

Before you install the software, make sure your computer meets these requirements:

- Microsoft® Windows 98 SE, XP, 2000, Me, or NT 4.0 (service pack 6a or later)
- Pentium® MMX 166 MHz processor (Pentium II 233 MHz or better recommended)
- At least 128MB of RAM (256MB or more recommended)
- At least 20MB of free hard disk space
- SVGA (800 × 600) or better display adapter and monitor

Installing the Software

Follow these steps to install the software:

1. Insert the projector software CD-ROM in your computer’s CD-ROM drive. The installer starts automatically.
2. Follow the on-screen instructions to install the software.

Once installed, you can access EMP Monitor from your computer’s Start menu.
Connecting and Configuring the Projector

Before using the Easy Management software to manage your projector(s), you have to connect each projector you want to monitor to your network and configure it with an IP address.

1. Connect the projector to your network using a commercially available 100BaseTX or 10BaseT network cable.

   Connect the cable to the LAN port on the projector as shown:

   ![LAN connection diagram](image)

2. Turn on the projector (see page 28).

3. Press the Menu button on the remote control, select Wired LAN from the Network menu, then press Enter.
4. If your network assigns addresses automatically, turn on the DHCP setting.

5. If your network does not assign addresses automatically, turn off DHCP and enter the projector’s IP Address, Subnet Mask, Gateway Address, and MAC Address, as needed.

   To enter numbers, use the pointer button on the remote control to highlight the number you want to input, then press the Enter button. When you’re finished changing an address in the network menu, highlight Finish, then press the Enter button.

6. When you’re done making all necessary changes, press Menu to exit the menu system.

### Using EMP Monitor

EMP Monitor lets you manage all your projectors using a remote computer. This lets you easily turn the projectors on or off (together or individually), switch image sources, and check on their status.

Before using EMP Monitor, make sure you’ve installed the software as described on page 74. The computer you’re using to monitor the projector should already be connected to your network.

### Opening and Closing EMP Monitor

To start EMP Monitor, click Start > Programs or All Programs > EPSON Projector > EMP Monitor.

If you’ve added the program to the Startup programs folder (see page 84), then it may already be open. If so, click the icon in the system tray on the lower-right corner of your screen to display the EMP Monitor window:

To close EMP Monitor, select Exit from the File menu or right-click the program icon shown above, then select Exit.
Registering a Projector

Before you can monitor a projector, you have to register it. Follow these steps to automatically search for your projector(s). To manually register your projector(s) with EMP Monitor, refer to the on-screen Operation Guide.

1. Open EMP Monitor as described above. You see this screen:

![EMP Monitor Interface]

2. Select Edit > New > Projector (automatic search).

You see this screen:

![Create new projector interface]
3. Click **Search** to locate projectors currently operating on the network.

Any projectors found on the network are listed as shown below:

![projector search interface]

4. Select the projector you want to add by clicking its name, then click the **Edit** button.

You see this screen:

![projector edit interface]

---

**note**

If the projector is not automatically found, your projector may not be connected or configured correctly for the network. See page 75.
5. Enter a Display name, select a Parent group, if necessary, enter a Monitor Password, if necessary, and a Description for the projector. Then click the Register button.

To register additional projectors with EMP Monitor, repeat steps 2 through 5.

6. When you’re done adding projectors, click Cancel.

You see a screen with a list of all registered projectors:

![List of registered projectors](image)

**Monitoring Your Projectors**

The EMP Monitor screen lets you monitor your projectors using the Status, Video Source, and Error icons shown below. This lets you see which projectors are currently being used, from which source (or port) they are projecting an image, and if a problem occurs.

For detailed status information, right-click the projector in question and click Property.

---

**note**

To delete a projector from the list, right-click the projector name, and click Delete.

**note**

To monitor a projector when it’s in standby mode (plugged in but not turned on), you must select Network On as the Standby Mode setting in the projector’s menu system (see page 59).
Managing the Projector from a Remote Computer

The following table explains the meaning of the Group status icons:

**Group status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Group Icon" /></td>
<td>No warnings or problems. All projectors in the group are operating normally.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td>Warning or problem. A projector in the group has a warning or problem.</td>
</tr>
<tr>
<td><img src="image" alt="Monitoring Disabled Icon" /></td>
<td>Monitoring disabled. Right click the icon and select Monitoring Enabled to begin monitoring the group.</td>
</tr>
<tr>
<td><img src="image" alt="Data Update Icon" /></td>
<td>Data is currently being updated.</td>
</tr>
</tbody>
</table>

**note**

To create projector groups in EMP Monitor, refer to the on-screen Operation Guide.

The following table explains the meaning of the Type status icons:

**Type status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Type Icon" /></td>
<td>No warnings or problems.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td>Warning or problem.</td>
</tr>
<tr>
<td><img src="image" alt="Password Error Icon" /></td>
<td>Monitor Password error. No monitor password was entered when the projector was registered, or an incorrect password was entered.</td>
</tr>
<tr>
<td><img src="image" alt="Monitoring Disabled Icon" /></td>
<td>Monitoring disabled. Right-click the icon and select Monitoring Enabled to begin monitoring the projector.</td>
</tr>
<tr>
<td><img src="image" alt="Data Update Icon" /></td>
<td>Data is currently being updated.</td>
</tr>
<tr>
<td><img src="image" alt="Network Error Icon" /></td>
<td>Network error (for example, the projector is not connected to the network, or power cable is disconnected). You may also see this error if Network Off is selected in Standby Mode (see page 59).</td>
</tr>
<tr>
<td><img src="image" alt="Communication Error Icon" /></td>
<td>Network error (Esc/VP.net communication error).</td>
</tr>
</tbody>
</table>
The following table explains the meaning of the Power status icons:

**Power status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>The projector is powered on and its status is normal.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>The projector is powered off and its status is normal.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>The projector is powered on and its status is abnormal.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>The projector is powered off and its status is abnormal.</td>
</tr>
</tbody>
</table>

The following table explains the meaning of the Temperature level status icons:

**Temperature level status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>The projector’s internal temperature is normal (low).</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>The projector’s internal temperature is normal (medium).</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>The projector’s internal temperature is normal (high).</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>The projector’s internal temperature is high (high-temperature warning).</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>The projector’s internal temperature is too high (internal temperature error). The projector is turned off automatically.</td>
</tr>
</tbody>
</table>

The following table explains the meaning of the error icons (see Chapter 7 for recommended solutions to problems):

**Error status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Lamp life warning. The lamp is nearing the end of its life; see page 93.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>High-temperature warning. The projector is getting too hot but continues to operate.</td>
</tr>
<tr>
<td><img src="image12.png" alt="Icon" /></td>
<td>Replace air filter; see page 91.</td>
</tr>
</tbody>
</table>
### Error status icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>No air filter. The air filter is not installed or installed incorrectly; see page 91.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Low air flow. The air filter needs to be cleaned or replaced; see page 91.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Air flow sensor error. There is a problem with the projector’s air flow sensor; contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Lamp cover door open. Close the lamp cover door; see page 93.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Lamp out. The lamp has reached the end of its life; see page 93.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Lamp failure at power on. The lamp has reached its end of life or is installed incorrectly; see page 93.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>High internal temperature error. The projector is turned off automatically.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Internal (system) error. Contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Fan error. Contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Sensor error. Contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>Other error. Contact Epson as described on page 109.</td>
</tr>
</tbody>
</table>
Controlling Your Projectors

The control buttons in the upper-right let you turn the projector on and off and select video sources. (Hold the mouse pointer over a button to see a description of its meaning.) Make sure you’ve selected the projector you want to operate (with the mouse pointer) before clicking one of the buttons.

note
To turn on a projector when it’s in standby mode (plugged in but not projecting), you must have selected Network On as the Standby Mode setting in the projector’s menu system (see page 59).
Configuring the Monitoring Interval

If you need to have the most current status information about your projectors, click the **Refresh** button in EMP Monitor.

To select how often EMP Monitor checks the status of projectors, follow the steps below:

1. From the Tool menu, select **Environment Setup**. You see this screen.

   ![Environment Setup Screen](image)

   **note**
   
   If you want EMP Monitor to run whenever you start your computer, click **Register at startup**.

2. Enter the desired Update interval and click **OK**.

   ![Register at startup](image)
Using E-mail Alerts

You can set up e-mail alerts to warn you of problems with the projector. Follow the steps below:

1. From the Tool menu, select Mail notification function. You see this screen:

2. Turn the Mail notification function setting On.

3. Enter the IP address and port number of your network’s SMTP (outgoing) mail server.

4. Enter the Sender (projector) mail address.

5. Enter up to three e-mail addresses to send alerts to in the Recipient mail address boxes.

6. Click the Notification event buttons to select the conditions under which an e-mail alert will be sent.

7. When you’re done, click the OK button to close the Set mail notification function window.
Managing the Projector from a Remote Computer

Understanding the Notification Messages

If a projector experiences a problem, EMP Monitor sends an e-mail message to each of the addresses you entered in the Set mail notification function window.

The subject line of the message includes the projector’s display name, shown in EMP Monitor, and the warning/error.

The body of the message contains:

- The projector’s display name in EMP Monitor
- The error/warning message

The problem descriptions are similar to the errors listed on page 81.

When the problem has been fixed, EMP Monitor sends a message indicating the problem has been resolved.

Using a Browser to Monitor the Projector

If your projector is connected to a network, you can use a standard web browser to monitor and control it.

1. Make sure that the projector is set up for your wired LAN network, as described on page 61. (Standby Mode in the Extended menu should be set to Network On to monitor the projector in standby mode.)

2. Open your web browser and enter the IP address of the projector you want to monitor in the browser window.

   If you’re not sure what the address of the projector is, turn the projector on and select Wired Lan from the Network menu to display the IP address of the projector.
You see a login screen like this one:

![Login Screen](image)

3. Do one of the following:
   - If you didn’t set a Web control password in the projector’s Network menu, click OK.
   - If you set a Web control password in the projector’s Network menu, enter it in the Password box, then click OK.

You see a screen like this one:

![Menu Screen](image)
4. Select one of the menu options listed on the left, then change any of the settings as needed. These settings correspond to those found in the projector’s menu system; for details, see Chapter 4.

You cannot change the following settings using a web browser:

- **Pointer** in the Settings menu
- **User’s Logo** in the Extended menu
- **Reset All, Reset Air Filter Time, or Reset Lamp Hours** in the Reset menu

5. Use the controls at the bottom of the screen just as you would the corresponding remote control buttons. Choose a source, stop the action, turn off the picture and sound, or turn the projector’s power on or off.
Maintaining the Projector

Your projector needs little maintenance. All you have to do on a regular basis is keep the lens cover glass clean. Any dirt or smears on the lens cover glass may show up on your projected image.

You also need to periodically clean the air filter at the side of the projector. A clogged air filter can block ventilation needed to cool the projector.

The only parts you should replace are the lamp and air filter. If any other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:
- Cleaning the lens cover glass
- Cleaning the projector case
- Cleaning the air filter
- Replacing the air filter
- Replacing the lamp
- Transporting the projector

**warning**

Before you clean any part of the projector, turn it off and unplug the power cord. Never open any cover on the projector, except the lamp cover. Dangerous electrical voltages in the projector can injure you severely. Do not try to service this product yourself, except as specifically explained in this User's Guide. Refer all other servicing to qualified service personnel.
Cleaning the Lens Cover Glass

Clean the lens cover glass whenever you notice dirt or dust on the surface.

- Use a canister of compressed air to remove dust.
- To remove dirt or smears on the lens, use a commercially available cloth for cleaning eyeglasses.

Cleaning the Projector Case

Before you clean the case, first turn off the projector and unplug the power cord.

- To remove dirt or dust, wipe the case with a soft, dry, lint-free cloth.
- To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent. Then wipe the case.
- Do not use wax, alcohol, benzene, paint thinner, or other chemical detergents. These can damage the case.
Cleaning the Air Filter

Clean the air filter when you see any of the following messages: The air filter is clogged. Clean or replace the air filter. or Check or Replace the air filter. If it is not cleaned periodically, it can become clogged with dust, preventing proper ventilation. This can cause overheating and damage the projector.

Follow these steps:

1. Turn off the projector and unplug the power cord.
2. Gently turn the projector over and push down on the tabs while opening the air filter cover. Then use a vacuum cleaner to clean the filter.

3. When you have finished cleaning the air filter, close the cover and reset the timer as described on page 92.
4. If the dirt is difficult to remove or a filter is broken, replace the filter as described below.

Replacing the Air Filter

Replace the air filter when you see the Check or Replace the air filter message. If it is not replaced, it can become clogged with dust, preventing proper ventilation. This can cause overheating and damage the projector.

To obtain a replacement air filter, contact your dealer or call Epson at (800) 873-7766 in the United States to obtain a new one. In Canada, please call (800) 463-7766 for dealer referral.

Note
If the air filter has been stained by tobacco smoke, it cannot be cleaned. Replace the filter as described below.
Follow these steps:

1. Turn off projector and unplug the power cord.
2. Turn projector upside down.
3. Remove the air filter by pushing down on the two tabs to release them.
4. Remove the air filter by pulling the center of air filter straight out.
5. Insert the new air filter with the tab facing the front of the projector.
6. Close the air filter cover.
7. Reset the air filter timer as described in the next section.

**Resetting the Air Filter Timer**

1. Plug the projector in and turn it on.
2. Press the Menu button on the remote control, select **Reset Air Filter Time** from the Reset menu, then press Enter.
3. When you see the confirmation message, select Yes, then press Enter.
4. When you’re finished, press Menu to exit the menu system.

*note*  
If the air filter has been stained by tobacco smoke, it cannot be cleaned. Replace the filter.

*note*  
The air filter usage timer shows 0H until you’ve used the filter for at least 10 hours.
**Replacing the Lamp**

The projection lamp typically lasts from 2500 to 3000 hours, depending on the Brightness Control setting used (see page 57). Selecting the Low brightness setting maximizes the lamp’s life.

It is time to replace the lamp when:

- The projected image gets darker or starts to deteriorate.
- The message **Replace the Lamp** appears on the screen and when the lamp comes on and the lamp warning light flashes orange. To maintain projector brightness and image quality, replace the lamp as soon as possible.
- The lamp warning light flashes red (the lamp is burnt out).

Contact your dealer or contact an Epson authorized reseller for a replacement lamp. Request part number V13H010L37. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).

Follow these steps to replace the lamp:

1. Turn off the projector.
2. When the Power light stops flashing, unplug the power cord.
3. Let the projector cool for at least an hour (if it has been on). The lamp is extremely hot immediately after use.
4. To release the lamp cover, insert the screwdriver included with the new lamp as shown, then remove the cover.

---

**note**

Turn off the projector when not in use to prolong the life of the projector.

You can check how long the lamp has been in use (see page 95).

Lamp life results will vary depending upon mode selected, environmental conditions and usage.

---

**warning**

Let the lamp cool fully before replacing it.

In the unlikely event that the lamp has broken, small glass fragments may be present and should be removed carefully to avoid injury.
5. Loosen the two screws holding the lamp in place (you can’t remove them).

6. Pull the lamp straight out.

7. Gently insert the new lamp.

8. Once the lamp is fully inserted, tighten its screws and replace the cover. (The projector won’t come on if the lamp cover is loose.)

9. Reset the lamp timer as described in the next section.

**note**

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.
**Resetting the Lamp Timer**

After you replace the lamp, you need to reset the lamp timer using the projector’s menu.

1. Plug the projector in and turn it on.
2. Press the Menu button on the remote control, select Reset Lamp Hours from the Reset menu, then press Enter.
3. When you see the confirmation message, select Yes, then press Enter.
4. When you’re finished, press Menu to exit the menu system.

**Transporting the Projector**

The projector contains many glass and precision parts. Follow these guidelines to prevent injury or damage:

- When hand-carrying the projector, you should use the handle to lift it only a short distance (for example, to set it on a table).
- When shipping the projector for repairs, use the original packaging material if possible. If you do not have the original packaging, use equivalent materials, placing plenty of cushioning around the projector.
- When transporting the projector a long distance, first place it in a hard-shell shipping case, and then pack it in a firm box, placing cushioning around the case.

---

**note**

The lamp usage timer shows 0H until you’ve used the lamp for at least 10 hours.

---

**note**

Epson shall not be liable for any damages incurred during transportation.
Maintaining the Projector
This chapter helps you solve problems with your projector, and tells you how to contact technical support for problems you can’t solve yourself. This chapter explains the following:

- Using the projector’s on-screen help system
- What to do when the projector’s status lights flash
- Solving problems with the image or sound
- Solving problems with Easy Management
- Solving problems with the remote control
- Contacting technical support
Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can get help by pressing the blue ? Help button on top of the projector or on the remote control. The following choices are available:

- No image appears on the screen
- The image is not in focus
- The image is unsteady
- The image colors don’t look right
- The image is too dark
- The image is distorted

Follow these steps to get help:

1. Press the green ? Help button on the projector.

You see the Help menu:

2. Use the ☰ pointer button on the remote control or the arrow buttons on the projector to highlight menu items.

3. After highlighting a menu item, press the Enter button on the remote control or on the projector to select it.

4. To exit the Help system, press the ? Help button.
If none of the suggestions solves your problem, see additional solutions to problems in the following sections.

Checking Projector Status

If your projector isn’t working correctly, first turn it off, wait for it to cool (the Power light stops flashing orange), and unplug it. Then plug the power cord back in and turn on the projector. If this doesn’t solve the problem, check the lights on top of the projector.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status and let you know when a problem occurs.

Refer to the following table for a complete description of the projector’s status lights and their meaning:

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>orange</td>
<td>The projector is in sleep mode. You can unplug it or press the Power button to turn it on.</td>
</tr>
<tr>
<td></td>
<td>flashing green</td>
<td>The projector is warming up. Wait for the image to appear.</td>
</tr>
<tr>
<td></td>
<td>green</td>
<td>The projector is operating normally.</td>
</tr>
<tr>
<td></td>
<td>red</td>
<td>High Temperature Warning. Although this is not an abnormal condition, projection will stop automatically if the temperature rises too high again. Make sure there is plenty of space around and under the projector for ventilation, and that the air filter is clean.</td>
</tr>
<tr>
<td></td>
<td>flashing orange</td>
<td></td>
</tr>
<tr>
<td>Light</td>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="green" alt="Green Light" /> <img src="orange" alt="Flashing Orange Light" /></td>
<td>green flashing orange</td>
<td>It’s time to replace the lamp. See page 93 for instructions. If you continue to use the lamp after the replacement warning, there is an increased possibility that the lamp may break.</td>
</tr>
<tr>
<td><img src="green" alt="Green Light" /> <img src="orange" alt="Orange Light" /></td>
<td>green orange</td>
<td>No air filter. Make sure that the air filter is securely installed; see page 91. If the error continues when the air filter is installed, there is a problem with the air filter sensor. Stop using the projector, disconnect the power cord, and contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="green" alt="Green Light" /> <img src="orange" alt="Flashing Orange Light" /></td>
<td>green flashing orange</td>
<td>Low air flow. If you see a message saying that the air filter is clogged, make sure that the air filter and is clean. If it is clogged replace it with a new filter; see page 91.</td>
</tr>
<tr>
<td><img src="red" alt="Red Light" /> <img src="red" alt="Flashing Red Light" /></td>
<td>red flashing red</td>
<td>There is a problem with the fan or temperature sensor. Stop using the projector, disconnect the power cable, and contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="red" alt="Red Light" /> <img src="red" alt="Red Light" /></td>
<td>red red</td>
<td>The projector is overheating, which turns the lamp off automatically. Wait until the cooling fan stops, about five minutes, then unplug the power cord. Plug the power cord back in and press the <strong>Power</strong> button. Make sure the room temperature is not above 95 °F (35 °C) and there is plenty of space around and under the projector for ventilation. The air filter may be clogged. Clean or replace it as described on page 91. If the projector continues to overheat after you clean the air filter, the problem may be caused by damage to the cooling fan or temperature sensor. Contact Epson for help. <strong>Warning:</strong> Except as specifically explained in this <em>User’s Guide</em>, do not attempt to service this product yourself.</td>
</tr>
<tr>
<td><img src="red" alt="Red Light" /> <img src="red" alt="Flashing Red Light" /></td>
<td>red flashing red</td>
<td>The lamp may be burned out. First make sure the lamp cover is securely installed. If that’s not the problem, remove the lamp and replace it as described on page 93. If this does not resolve the problem, contact Epson as described on page 109. The lamp may be cracked or installed incorrectly. Check the lamp; if it is cracked, you must replace it (as described on page 93) before you can use the projector again. If checking the lamp installation and replacing the lamp does not solve the problem, contact Epson as described on page 109.</td>
</tr>
<tr>
<td><img src="red" alt="Red Light" /> <img src="red" alt="Flashing Red Light" /></td>
<td>red flashing red</td>
<td>The projector is shut down automatically because of an internal problem. Remove the power cord and contact Epson for help, as described on page 109.</td>
</tr>
</tbody>
</table>
Viewing Lamp Usage and Other Information

Use the About menu to view information about the image source, the display settings of your computer, and the number of hours the lamp and filter has been used.

Press the Menu button, select Info, then press Enter.

You see the lamp and air filter usage hours and various input signal settings on the right:

![Diagram showing lamp usage and air filter usage]

The lamp typically lasts from 2500 to 3000 hours, depending on the selected Brightness Control setting (see page 57). If the number shown is close to that, make sure you have a spare lamp handy. If you’ve installed a new lamp, be sure to reset the lamp timer (see page 95).

**Note**

The information displayed depends on the input signal currently selected.
Solving Problems with the Image or Sound

The Power light does not come on.

Make sure the power cord is connected securely both at the power outlet and the projector. If you have just replaced the lamp, make sure the cover is securely fastened.

No image appears on the screen.

- Check that the Power light is green and not flashing.
- The projector may be in sleep mode. If the Power light is orange, press the Power button to turn the projector on.
- Try pressing the other Power button on the remote control or on the projector.
- Press the A/V Mute button to make sure the picture has not been turned off temporarily.
- The attached computer may be in sleep mode or displaying a black screen saver. Try pressing a key on the computer.

You’ve connected a computer and see a blue screen with the message No Signal displayed.

- Make sure the cables are connected correctly, as described in Chapter 1.
- Try restarting your computer.
- If you’ve connected a computer and one or more video sources, you may need to press the Source Search button on the projector or remote control to select the correct source. Allow a few seconds for the projector to sync up after pressing the button.
If you’re using a PC notebook:

- Hold down the **Fn** key on the keyboard and press the function key that lets you display on an external monitor. It may have an icon such as ![icon](image), or it may be labelled CRT/LCD. Allow a few seconds for the projector to sync up after pressing it. Check your notebook’s manual or online help for details.

  On most systems, the ![icon](image) key lets you toggle between the LCD screen and the projector, or display on both at the same time.

- Depending on your computer’s video card, you might need to use the Display utility in the Control Panel to make sure that both the LCD screen and external monitor port are enabled. See your computer’s documentation or online help for details.

If you’re using Mac OS X:

1. Open **System Preferences**.
2. Double-click **Displays**.
3. Make sure the **VGA Display** or **Color LCD** dialog box is selected.
4. Click the **Arrange** tab.
5. Make sure the **Mirror Displays** checkbox is selected.

If you’re using Mac OS 8.6 to 9.x:

1. From the Apple menu, select **Control Panels**, then click **Monitors and Sound**.
2. Click the **Arrange** icon.
3. Drag one monitor icon on top of the other. This lets you display on the projector screen as well as the LCD screen.
4. If this option isn’t available, click the **Monitor** icon.
5. Select one of the listed **Simulscan** resolutions. (Allow a few seconds for the projector to sync up after making the selection.)
The message Not Supported is displayed.

- Make sure the correct input signal is selected in the Settings menu (see page 55).
- Make sure your computer’s resolution doesn’t exceed UXGA (1600 × 1200), and the refresh rate is supported by the projector (see page 118). If necessary, change your computer’s resolution setting as described in the following section.

Only part of the computer image is displayed.

- Press the Auto button on the remote control.
- Make sure the image Position setting is correct on the Signal menu. See Chapter 4 for more information.
- Make sure your computer’s resolution setting is correct. Ideally, it should be 1024 × 768 to match the projector’s native resolution. If this option isn’t available, select one of the other compatible video formats listed on page 118.
  - Windows:
    Right-click the desktop, select Properties, click the Settings tab, and select a different resolution.
  - Mac OS X:
    Open System Preferences, double-click Displays, and then select a different resolution.
  - Mac OS 8.6 to 9.x:
    On the Apple menu, choose Control Panels, then click Monitors and Sound. Select a different resolution.
- You also may need to modify existing presentation files if you created them for a different resolution. See your software documentation for specific information.
The image isn’t square, but keystone-shaped.

- If the top or bottom of the image is broader, press the □ or △ button on the projector until the image is square.
- If the projector is angled toward the screen from the left or right, the image will be broader on one side. Center the projector in front of the middle of the screen, facing the screen squarely.

The image contains static or noise.

- Make sure the correct Input Signal is selected in the Signal menu (see Chapter 4).
- If you’re using a computer cable longer than 6 feet (2 meters), or an extension cable, the image quality may be reduced.
- Keep your computer and video cables away from the power cord as much as possible to prevent interference.
- The video signal may be split between the computer and the projector. If you notice a decline in the projected image quality when the image is displayed simultaneously on your notebook computer and the projector, turn off the notebook’s LCD display.

The image is blurry.

- There may be dirt or smears on the lens cover glass. Clean the lens cover glass as described on page 90.
- Adjust the focus using the focus ring.
- Make sure the lens is not fogged by condensation. You may need to wait before using the projector after moving it from a cold environment to a warm environment.
- Make sure the projector is within the recommended projection distance (2.5 to 36.5 feet).
Adjust the **Sharpness** setting on the Image menu (see Chapter 4). When you change video settings, you should be able to see the effect on the screen immediately. If you’re projecting from a computer, you may also need to adjust the tracking and sync as described in the next section. If you don’t like the new settings, you can always select **Reset** to return to the factory default settings.

You see vertical stripes, or the image still looks blurry after trying the solutions in the previous section.

- If you’re projecting from a computer and displaying an image that contains a lot of fine detail, you may notice one or more vertical stripes or bands, or some of the characters may look heavy or blurred. Press the **Auto** button on the remote control. This resets the projector’s tracking and sync settings.

- If further adjustment is needed, you can fine-tune the **Tracking** and **Sync** settings manually using the Signal menu as described in Chapter 4.

1. Fill the screen with an image containing fine detail when making these adjustments. For example, in Windows you can select a pattern to appear as your desktop background. If this option isn’t available, try projecting black text on a white background.

2. Adjust the **Tracking** to eliminate vertical stripes.

3. Adjust the **Sync** setting to increase the sharpness of the image.
The colors of the image are not right.

- If you’re displaying a computer image, use the Color Mode option in the projector’s Image menu to adjust the color. If you’re displaying video, adjust the Color, Tint, and Color Mode settings on the Image menu.
- Try changing the Color Adjustment setting on the Image menu.
- Check your computer display settings to correct the color balance.

There is no sound.

- Make sure the A/V Mute button has not been pressed.
- Try adjusting the Volume setting in the Settings menu (see page 57).
- If you’re using a VCR or other video source, make sure the volume is not turned all the way down or muted. Also, make sure the cables are connected correctly, as described in Chapter 1.
- If your presentation includes computer audio, make sure the volume control on your computer is not turned all the way down or muted. If you’re using the audio cable, make sure it is securely connected to both the projector and your computer’s headphone jack or audio out jack.
- Make sure the Windows volume controls on your computer are not turned all the way down or set to Mute. You may be able to check this by clicking the volume control in your Windows System Tray (lower right corner of the screen).
Solving Easy Management Problems

You don’t see your projector in the EMP Monitor window.

- Make sure that you’ve connected the projector to the network and configured it correctly; see page 75. Also, make sure you’ve registered the projector with EMP Monitor. See page 77.
- Make sure that Standby Mode in the Extended menu is set to Network On.
- If the computer you are using is running Windows XP, 2000, or NT 4.x, you must be logged in as the Administrator.
- Try restarting your computer.

Solving Problems with the Remote Control

The projector doesn’t respond to remote control commands.

- If you’re using the remote control for the first time, make sure the batteries are installed, as shown on page 43.
- The remote control’s batteries may not be installed correctly or may be low on power. To change the battery, see page 43.
- Make sure you are within 33 feet (10 meters) of the projector, and within range of the projector’s front or back sensor (approximately 30° to the left or right and 15° above or below).
- Dim the room lights and turn off any fluorescent lights. Make sure the projector is not in direct sunlight. Strong lighting, especially fluorescent lights, may affect the projector’s infrared receivers. Also, turn off any nearby equipment that emits infrared energy, such as a radiant room heater.
- Make sure the projector’s remote receivers aren’t turned off; see page 57.
Where To Get Help

Internet Support
Visit Epson’s support website at http://support.epson.com and select your product for solutions to common problems. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Visit http://www.presentersonline.com to access tips, templates, and training for developing successful presentations.

Speak to a Support Representative
To use the Epson PrivateLine Support service, call (800) 637-7661 and enter the PIN on the included Epson PrivateLine Support card. This is the fastest way of speaking to a live representative, and it’s free. This service is available 6 AM to 6 PM, Pacific Time, Monday through Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one of these numbers (toll or long distance charges may apply):

- U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Before you call, please have the following information ready:

- Product name (Epson PowerLite 6100i)
- Product serial number (located on the back of the projector)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer or video configuration
- Description of the problem
Purchase Supplies and Accessories

You can purchase screens, carrying cases, or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
Appendix A: Projector Installation

This appendix provides guidelines on installing the projector in a permanent location, such as a theater or conference room.

Installation Guidelines

The projector can be installed for four different viewing setups: front projection, ceiling mounting, rear projection onto a semi-transparent screen, or rear/ceiling projection, as shown:

- Front projection
- Rear projection
- Front/ceiling projection
- Rear/ceiling projection
Appendix A: Projector Installation

To project from overhead, you’ll need the optional ceiling mounting hardware; see page 12 for ordering information. You’ll also need to select Front/Ceiling or Rear/Ceiling in the projector’s Extended menu to flip the image upside-down. To project from the rear, select Rear (see page 59).

If you’re mounting the projector on the ceiling and you place it above screen level, you’ll have to tilt it down to position the image on-screen. This causes the image to lose its square shape. You can then correct the distortion by using the Keystone function in the projector’s menu system (see page 56) or by using the ▲ or ▼ buttons on the projector’s control panel.

If you place the projector so that the lens is level with the bottom of the screen, the image will be square and you won’t have to adjust it. If you place the lens lower than the bottom of the screen, you may have to tilt the projector upward if you want to fill the whole screen with the image.

If you want to be able to control the projector’s settings from a remote computer, see Chapter 5.

warning
When installing or adjusting the ceiling mount, do not use adhesives to prevent the screws from loosening and do not use any type of oil or lubricant. These may cause the projector casing to crack and the projector may fall, causing serious injury and serious damage to the projector.
Installing the Rear Cable Cover and Lock

If you’re mounting the projector on the ceiling, you can install the rear cable cover to enhance the cosmetic appearance of the system.

To install the cover, insert the cover’s tabs into the slots as shown, then attach it with the two included screws.

For security purposes, you can also install a lock to ensure that the cable cover is not removed.
Appendix B: Technical Specifications

**General**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of display</td>
<td>Poly-silicon TFT active matrix</td>
</tr>
<tr>
<td>Size of LCD panels</td>
<td>Diagonal: 0.8 inch</td>
</tr>
<tr>
<td>Resolution (native format)</td>
<td>1024 × 768 pixels (XGA)</td>
</tr>
<tr>
<td>Color reproduction</td>
<td>24 bit, 16.7 million colors</td>
</tr>
<tr>
<td>Brightness</td>
<td>3500 lumens (high brightness mode)</td>
</tr>
<tr>
<td></td>
<td>2700 lumens (low brightness mode)</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>500:1</td>
</tr>
<tr>
<td>Image size</td>
<td>30 to 300 inches</td>
</tr>
<tr>
<td>Projection distance</td>
<td>2.5 to 36.5 feet (0.8 to 11 meters)</td>
</tr>
<tr>
<td>Projection methods</td>
<td>Front, rear, upside-down (ceiling mount)</td>
</tr>
<tr>
<td>Internal sound system</td>
<td>5 W monaural</td>
</tr>
<tr>
<td>Optical aspect ratio</td>
<td>4:3 (horizontal:vertical)</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>1 to 1.6</td>
</tr>
<tr>
<td>Noise level</td>
<td>39 dB standard filter; 44dB smoke filter</td>
</tr>
<tr>
<td>Keystone correction</td>
<td>± 30° (vertical)</td>
</tr>
</tbody>
</table>
**Projection Lamp**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>UHE (Ultra High Efficiency)</td>
</tr>
<tr>
<td>Power consumption</td>
<td>230 W</td>
</tr>
<tr>
<td>Lamp life</td>
<td>Up to 2500 hours (high brightness mode)</td>
</tr>
<tr>
<td></td>
<td>Up to 3000 hours (low brightness mode)</td>
</tr>
<tr>
<td>Part number</td>
<td>V13H010L37</td>
</tr>
</tbody>
</table>

**Remote Control**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>33 feet (10 meters)</td>
</tr>
<tr>
<td>Batteries</td>
<td>(2) Alkaline size AAA</td>
</tr>
</tbody>
</table>

**Dimensions**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>5.75 inches (146 mm) [not including feet]</td>
</tr>
<tr>
<td>Width</td>
<td>18.3 inches (465 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>13.39 inches (340 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>15.4 lb (7 kg)</td>
</tr>
</tbody>
</table>

**Electrical**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated frequency</td>
<td>50/60 Hz AC</td>
</tr>
<tr>
<td>Power supply</td>
<td>100 to 120 VAC, 3.7 A</td>
</tr>
<tr>
<td></td>
<td>200 to 240 VAC, 1.6 A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Operating: 310 to 330 W</td>
</tr>
<tr>
<td></td>
<td>Standby: 0.4 to 0.7 W with Network Off</td>
</tr>
<tr>
<td></td>
<td>9 to 10 W with Network On</td>
</tr>
</tbody>
</table>

**Note**

Turn off this product when not in use to prolong the life of the projector.

Lamp life results will vary depending upon mode selected, environmental conditions and usage.

*Appendix B: Technical Specifications*
### Environmental

- **Temperature**
  - Operating: 32 to 104 °F (0 to 40 °C)
  - Storage: 14 to 140 °F (–10 to 60 °C)
- **Humidity**
  - Operating: 20 to 80% RH, non-condensing
  - Storage: 10 to 90% RH, non-condensing
- **Operating altitude**
  - 0 to 9,843 ft (0 to 3,000 m)

### Safety

- **United States**
  - FCC Part 15B Class B (DoC)
  - UL60950-1
- **Canada**
  - ICES-003 Class B
  - CSA C22.2 No. 60950-1
- **CE Marking**
  - Directive 73/23/EEC
  - Directive 89/336/EEC
  - EN 55022, EN 55024

Pixelworks™ DNX™ ICs are used in this projector.
Compatible Video Formats

The projector supports NTSC, PAL, and SECAM international video standards, as well as the monitor display formats listed below.

To project images output from a computer, the computer’s video card must be set at a refresh rate (vertical frequency) that’s compatible with the projector; see the following table for compatible formats. As noted below, some images are automatically resized to display in the projector’s “native” format (XGA). In addition, the frequencies of some computers may not allow images to display correctly; see your computer’s documentation for details.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Refresh Rate (Hz)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGAEGA</td>
<td>70</td>
<td>640 × 350*</td>
</tr>
<tr>
<td>VGA—60</td>
<td>60</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VGA—72</td>
<td>72</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VGA—75</td>
<td>75</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VGA—85</td>
<td>85</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>SVGA—56</td>
<td>56</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—60</td>
<td>60</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—72</td>
<td>72</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—75</td>
<td>75</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—85</td>
<td>85</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>XGA—60</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—70</td>
<td>70</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—75</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—85</td>
<td>85</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SXGA1—70</td>
<td>70</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA1—75</td>
<td>75</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA1—85</td>
<td>85</td>
<td>1152 × 864</td>
</tr>
<tr>
<td>SXGA2—60</td>
<td>60</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—75</td>
<td>75</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—85</td>
<td>85</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA3—60</td>
<td>60</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—75</td>
<td>75</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—85</td>
<td>85</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>UXGA—60</td>
<td>60</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>Mode</td>
<td>Refresh Rate (Hz)</td>
<td>Resolution</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>MAC13</td>
<td>67</td>
<td>640 × 480∗</td>
</tr>
<tr>
<td>MAC16</td>
<td>75</td>
<td>832 × 624∗</td>
</tr>
<tr>
<td>MAC19</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC21</td>
<td>75</td>
<td>1152 × 870∗</td>
</tr>
<tr>
<td>NTSC</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>NTSC 4:43</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>N-PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>M-PAL</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL—60</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>SECAM</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>SDTV (525i)</td>
<td>60</td>
<td>720 × 480∗</td>
</tr>
<tr>
<td>SDTV (525p)</td>
<td>60</td>
<td>720 × 480∗</td>
</tr>
<tr>
<td>SDTV (625i)</td>
<td>50</td>
<td>720 × 576∗</td>
</tr>
<tr>
<td>SDTV (625p)</td>
<td>50</td>
<td>720 × 576∗</td>
</tr>
<tr>
<td>HDTV (750p)</td>
<td>50/60</td>
<td>1280 × 720∗</td>
</tr>
<tr>
<td>HDTV (1125i)</td>
<td>50/60</td>
<td>1920 × 1080∗</td>
</tr>
</tbody>
</table>

∗The image is resized using Epson’s SizeWise™ Technology.
Appendix C: Notices

This appendix includes safety instructions and other important information about your Epson PowerLite projector.

Important Safety Instructions

Follow these safety instructions when setting up and using the projector:

■ Do not place the projector on an unstable cart, stand, or table.
■ Do not use the projector near water or sources of heat.
■ Use the type of power source indicated on the projector. If you are not sure of the power available, consult your dealer or power company.
■ Place the projector near a wall outlet where the plug can be easily unplugged.
■ Insert the projector’s three-wire grounding-type plug into a properly grounded outlet. If you have a two-prong outlet, contact an electrician to replace it. Do not hold the plug with wet hands.
■ Take the following precautions for the plug. Failure to comply with these precautions could result in sparks or fire: Do not insert the plug into an outlet with dust present. Insert the plug firmly into the outlet.
■ Do not overload wall outlets, extension cords, or integral convenience receptacles. This can cause fire or electric shock.
■ Do not place the projector where the cord can be walked on. This may result in fraying or damage to the plug.
■ Unplug the projector from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not use liquid or aerosol cleaners.
■ Do not block the slots and openings in the projector case. They provide ventilation and prevent the projector from overheating. Do not operate the projector on a sofa, rug, or other soft surface, or in a closed-in cabinet unless proper ventilation is provided.
■ Never push objects of any kind through the cabinet slots. Never spill liquid of any kind into the projector.
■ Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified personnel. Opening or removing covers may expose you to dangerous voltages and other hazards.

■ Unplug the projector from the wall outlet and refer servicing to qualified service personnel under the following conditions: When the power cord or plug is damaged or frayed. If liquid has been spilled into the projector, or if it has been exposed to rain or water. If it does not operate normally when you follow the operating instructions, or if it exhibits a distinct change in performance, indicating a need for service. If it has been dropped or the housing has been damaged.

■ The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.

■ Unplug the projector during lightning storms or when it will not be used for extended periods.

■ Do not place the projector and/or remote control on top of heat-producing equipment or in a hot location.

■ If you use the projector in a country other than where you purchased it, use the correct power cord for that country.

■ Do not stand on the projector or place heavy objects on it.

■ Do not use the projector outside of the required temperature range of 41 to 104 °F (5 to 40 °C). Doing so may cause an unstable display and could lead to projector damage.

■ Do not store the projector outside of the required temperature range of 14 to 140 °F (–10 to 60 °C) or in direct sunlight for long periods of time. Doing so may cause damage to the case.

WARNING: The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling. (provided in accordance with Proposition 65 in Cal. Health & Safety Code § 25249.5 et seq)
**Declaration of Conformity**

According to 47CFR, Part 2 and 15, Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers

We: Epson America, Inc.
Located at: 3840 Kilroy Airport Way
MS: 3-13
Long Beach, CA 90806-2469

Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed, is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Projector
Model: EMP-6100
Marketing Name: PowerLite 6100i
**FCC Compliance Statement**

**For United States Users**

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING**

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

**For Canadian Users**

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

*Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.*
Warranty

Epson America, Inc. Limited Warranty

Basic Two-Year Warranty and 90-Day Lamp Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser of the Epson product enclosed with this limited warranty statement that the product, if purchased new and operated in the United States or Canada, will be free from defects in workmanship and materials for a period of two (2) years from the date of original purchase (except that the warranty period is 90 days for projector lamps). For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: If your product requires service, Epson will ask you to bring the product securely packaged in its original container or equivalent, along with proof of the date of original purchase, to your Epson Dealer or Epson Customer Care Center as instructed by Epson. Epson will, at its option, repair or replace the defective unit, without charge for parts or labor. When warranty service involves the exchange of the product or of a part, the item replaced becomes Epson property. The exchanged product or part may be new or previously refurbished to the Epson standard of quality, and at Epson’s option, the replacement may be another model of like kind and quality. Epson’s liability for replacement of the covered product will not exceed the original retail selling price of the covered product. Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited warranty. However, each replacement lamp carries the limited 90-day warranty stated above.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use of the product. 24-hour-per-day or other excessive continual use causes strain and is not considered normal use. This warranty does not cover consumables (e.g., fuses), other than lamps. This warranty is not transferable. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed. Epson is not responsible for warranty service should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. Postage, insurance, or shipping costs incurred in presenting your Epson product for carry-in warranty service are your responsibility. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON’S ENTIRE LIABILITY SHALL BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE EPSON PRODUCT COVERED BY THIS LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights, which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://support.epson.com.

You can also call the Epson ConnectionSM at (800) 637-7661 + PIN or (562) 276-4394 in the U.S. and (905) 709-3839 in Canada or write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.
Index

A
A/V Mute, 44, 58, 102
Accessories, 12, 110
Address Setting, 62
Adjustment Level setting, 60
Air filter
  cleaning, 91
  high efficient, 12
  number of hours used, 64
  ordering, 12
  replacing, 91 to 92
  smoke, 12
  timer, resetting, 92
Air Filter Setting, 59
Alarm Timer setting, 59
Anti-theft device, 12, 15
Aspect ratio, 56, 115
Audio
  adjusting volume, 38, 57
  cable, 8, 26
  connecting equipment, 25 to 26
  problems, troubleshooting, 107
  turning off (using A/V Mute), 44
Auto button, 38, 55
Auto Setup setting, 38, 55

B
Background setting, 58, 67
Batteries, replacing, 43
Blackboard color mode, 52
Blank screen, 31 to 33, 102 to 103
Blurry image, 105
Brightness, 7, 115
Brightness Control setting, 57
Brightness Correct setting, 60
Brightness setting, 53
Buttons, disabling projector, 56, 71

C
Cables
  BNC, 21
  component-to-VGA, 12, 19
  composite (RCA), 17
  illustrations, 11
  ordering, 12
  S-Video, 11, 12, 18
  VGA computer, 11, 23
Ceiling
  mount, 12, 111
  projection, 59, 112
Cleaning
  air filter, 91
  lens cover glass, 90
  projector case, 90
Closed Caption setting, 58
Color
  adjusting, 52 to 53, 60
  problems, 107
  specifications, 115
Color Adjustment setting, 53
Color Mode setting, 52
Color Saturation setting, 53
Community Name setting, 62
Component video cable, 12, 19
Component video source, selecting, 30
Composite (RCA) video cable, 16 to 17
Computer
  cable, 11, 22 to 23
  connecting to, 22 to 23
  correcting images, 38
  selecting source, 30
  supported display formats, 118 to 119
Computer1 Input setting, 55
Computer2 Input setting, 55
Connecting projector
to a computer, 22 to 23
to audio equipment, 25 to 26
to video equipment, 16 to 21
Contrast ratio, 7, 115
Contrast setting, 53

D
Declaration of Conformity, 123
Default password, 65
Default settings, restoring, 51
DHCP setting, 61
Dimensions, 116
Direct Power On setting, 59
Display setting, 58
Distance from projector to screen, 14, 115
Documentation, 9
DVD player, connecting, 16 to 21

E
Easy Management
configuring the projector, 75 to 76
installing software, 74
monitoring the projector, 76 to 84
problems, 108
system requirements, 74
Electrical specifications, 116
EMP Monitor
changing monitoring interval, 84
installing software, 74
using, 76 to 84
Enter button, 42
Entering the password, 71
Environmental specifications, 117
Epson
accessories, 12, 93, 110
Extra Care Road Service, 10
help, 9, 109 to 110
presentation tips, 9
PrivateLine Support, 9, 109
technical support, 9, 109 to 110
Esc button, 42

Extended menu, 58 to 60
Extra Care Road Service, 10
E-Zoom button, 45, 45

F
FCC compliance statement, 124
Filter, see Air filter
Focusing image, 34
Freeze button, 45
Front projection, 59, 111
Front/Ceiling projection, 59, 111

G
Game color mode, 52
Gateway Address setting, 61

H
Height of image, adjusting, 35
Help system, using, 98 to 99
Help, Epson, 9, 109 to 110
High Altitude Mode setting, 59
High brightness, 57, 115, 116
HP OpenView, 73

iBook, connecting to projector, 22 to 23
Image
adjusting, 34 to 38, 52 to 56
capturing and saving in projector, 65 to 67
correcting shape, 36 to 37, 105
fitting on screen, 14, 34, 104
freezing, 45
height, adjusting, 35
menu, 52 to 53
positioning, 35, 55
problems with, 102 to 107
raising, 35
selecting source, 30, 44
shape, correcting, 36 to 37
size and projection distance, 14, 115
turning off (using A/V Mute), 44
zooming, 34, 45
Image Correction setting, 60
Info menu, 63 to 64, 101
Input signal, selecting, 30, 44
Installing projector, 111 to 112
IP Address setting, 61

K
Kensington anti-theft device, 12, 15
Keystone correction, 36 to 37, 56, 105, 112, 115

L
Lamp
  automatic shutoff, 39
  brightness, 57
  number of hours used, 63, 101
  ordering, 12
  replacing, 93 to 95
  specifications, 116
  status light, 99 to 100
  timer, resetting, 95
Language setting, 60
LCD panels, 115
Lens
  access door, 34
  cover glass, cleaning, 90
Lights, status, 99 to 100
Logo
  creating, 65 to 67
  displaying, 59, 67 to 68
  protecting, 69
Low brightness, 57, 115, 116

M
MAC Address, 61
Mail setting, 62
Manuals, 9
Menus
  changing settings, 50 to 51
  default settings, restoring, 51
  Extended, 58 to 60
  Image, 52 to 53
  Info, 63 to 64, 101
  Network, 61 to 62
  Reset, 51
  Settings, 56 to 57
  Signal, 54 to 56
  using, 50 to 51
Message setting, 58
Monitor, connecting external, 24
Monitoring projector
  EMP Monitor, 76 to 84
  HP OpenView, 73
Moving projector, 95
Multi-screen setting, 60

N
Network
  managing projector remotely, 73 to 88
  settings, 61 to 62
New Hardware Wizard, 29
No Signal message, 31, 102 to 103
Noise level, 115
Notebook computer
  connecting to projector, 23
  display problems, 31 to 33, 102 to 104
  selecting source, 30

O
Operation setting, 59
Optical aspect ratio, 115
Options for projector, 11 to 12
Password
  default, 65
  entering, 71
  logo protection, 69
  problems, 71
  prompt, 65, 71
  request code, 71
  setting, 68
  turning on, 70
Photo color mode, 52
Picture source, selecting, 30, 44
Picture, see Image
Pixelworks, 117
PJLink Password, 61
Pointer Shape setting, 57
Pointer tool, using, 46 to 47
Port Number setting, 62
Position setting, 55
Positioning
  image, 35
  projector, 14
Power
  button, 29
  consumption, 116
  light, 99 to 100
  saving, 59
  specifications, 116
  status light, 29, 99 to 100
  supply, 116
PowerBook, connecting to projector, 22 to 23
Presentation color mode, 52
Presentations
  tips and training, 9
  using the pointer tool, 46 to 47
Presenters Online, 9, 109
PrivateLine Support, 9, 109

Problems
  color, 107
  image, 102 to 107
  monitoring projector, 108
  no signal, 31, 102 to 103
  password, 71
  remote control, 108
  sound, 107
  using on-screen help, 98 to 99
Projection distance, 14, 115
Projection lamp, see Lamp
Projection setting, 59
Projector
  accessories, 12
  cleaning, 90
  connections, see Connecting projector
disabling buttons, 56, 71
distance from screen, 14, 115
feet, adjusting height with, 35
installing, 111 to 112
lamp specifications, 116
monitoring remotely, 73 to 88
options, 12
password protection, 70
positioning, 14 to 15
resolution, 115
specifications, 115 to 117
transporting, 95
troubleshooting, 97 to 100
turning off, 39
turning on, 28 to 29
unpacking, 11
viewing information about, 101
Projector Name setting, 62

Quick Setup sheet, 9
Raising image, 35
RCA Audio Input setting, 57
RCA-style video cable, 17
Rear projection, 59, 111
Rear/Ceiling projection, 59, 111
Registration, 10
Remote control
  batteries, 116
  problems, 108
  range, 116
  replacing batteries, 43
  specifications, 116
  troubleshooting, 108
  using, 41 to 47
Remote Receiver setting, 57
Replacing
  air filter, 91 to 92
  lamp, 93 to 95
  remote control batteries, 43
Request code, password, 71
Resetting
  air filter timer, 92
  lamp timer, 95
Resetting menu options, 51
Resize setting, 56
Resolution, 115

Safety
  instructions, 121 to 122
  specifications, 117
Screen
  blank, 31 to 33, 102 to 103
  distance from projector, 14, 115
  ordering, 12
Screen ID setting, 60
Screen image, See Image
SDTV formats, supported, 119
Security, Kensington lock, 12, 15
Settings menu, 56 to 57
Sharpness setting, 53
Signal menu, 54 to 56
Sleep mode, 39, 59
SMTP Server setting, 62
SNMP setting, 62
Software installation, 74
Sound
  adjusting, 38, 57
  troubleshooting, 107
Source
  selecting, 30, 44
  viewing, 101
Speaker, specifications, 115
Speakers, connecting, 26
Specifications
  brightness, 115
  dimensions, 116
  electrical, 116
  environmental, 117
  general, 115
  lamp, 116
  remote control, 116
  resolution, 115
  safety, 117
  speaker, 115
Sports color mode, 52
sRGB color mode, 52
Status lights, 99 to 100
Subnet Mask setting, 61
Support, Epson, 9, 109 to 110
S-Video cable, 11, 12, 18
Switching picture source, 30, 44
Sync. setting, 55
Synchronization, adjusting, 38, 55, 106
System requirements, 74
T

Technical support, 9, 109 to 110
Temperature
  requirements, 117
  status light, 99 to 100
Test Pattern setting, 57
Theatre color mode, 52
Timer setting, 59
Tint setting, 53
Tracking, adjusting, 38, 55, 106
Transporting projector, 95
Trap IP Address setting, 62
Troubleshooting
  blank screen, 31 to 33, 102 to 103
  cut-off image, 104
  distorted image, 36
  Easy Management, 108
  image and sound problems, 102 to 107
  no signal, 31, 102 to 103
  projector problems, 97 to 100
  remote control problems, 108
Turning off picture (using A/V Mute), 44, 58, 102
Turning off projector, 39
Turning on projector, 28 to 29

U

Unpacking projector, 11
User’s Logo setting, 59

V

VCR, connecting, 16 to 21
VGA computer cable, 11, 23
Video
  cables, 11 to 12, 16 to 21
  connecting video equipment, 16 to 21
  display settings, viewing, 58, 101
  formats, supported, 118 to 119
  selecting source, 30, 44
Video Signal setting, 55
Volume setting, 57
Volume, adjusting, 38, 57

W

Warning lights, 99 to 100
Warranty, 10, 125 to 126
Web Control Password, 61
Wired LAN setting, 61

Z

Zoom ratio, 115
Zooming image, 34, 45